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Release Notes for DEPOCAM v18.0.15        24st January 2023 

 

8599: Import: Datakit libraries have been updated to 2023.1. This version supports SOLIDWORKS 2023.  
In addition a problem with failing to load NX files has been fixed. Also fixes #8584. 
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Release Notes for DEPOCAM v18.0.14      01st December 2022 

 

8425: UI: Removed Disable accelerated selection from Options > Graphics. It is no longer needed. 
 
8431: Import: Update Datakit libraries to 2022.4. Supports Parasolid V35.0 and the latest NX version 2206. 
 

 
 
 
8453: UI: Improved selection performance when clicking on a single surface with the mouse. 
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Release Notes for DEPOCAM v18.0.13       27th July 2022 
 
8010: Import: There were occasions when reading surfaces from an IGES file with the Convert to NURB 
option, that some surfaces may not be read in, this has now been fixed.  
 
8241: Triangulation: Fixed a rare problem where the surface quality could be worse for a tighter tolerance. This 
happened sometimes with very complex surfaces. 
 
8261: Post processors: Heidenhain Master, ISO Master and Siemens Master: Added the option Output Tool 
name not Tool number to allow the tool name to be output in place of the tool number, in keeping with the 
main post processors. The default setting is false so existing post processors are not affected. 
8267: Fixed a crash that could occur when loading a large database. 
 
8310: Import: Fixed a crash that could occur when loading geometry files using a direct interface like Parasolid. 
 
8316: Import: The Datakit libraries are updated to 2022.3. This supports the latest NX version 2027. 
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Release Notes for DEPOCAM v18.0.12      11th May 2022 
 
8174: User Interface: Fixed an instance where a folder could be unintentionally deleted when moved in the 
contents tree. 
 
8178: UI: Along Curve Passes: Due to a change in recent versions, the Bounding Box dialog was displayed to 
specify the rotation model (AC; BC...) even when the tool axis was not rotated. Now the Bounding Box dialog 
is only displayed when the tool axis is rotated for a 3+2 machining, and the rotation model is not defined. Since 
the rotation model is irrelevant when machining with the tool axis in Z. 
 
8197: Import: The Datakit libraries have been updated to 2022.2. This now supports: 
 

- CATIA version R32 
- Parasolid V34.1 
- NX version 2015.  

 

 
 
 
8214: Import: Updated the Granite reader to v15.0.0.0. This provides support for Creo 9.0 files 
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8218: 5 axis: When working with the 5 axis module in 3 axis, a 3+2 toolpath can be generated by selecting a 
folder with a rotated boundary when the toolpath is created. As is the case when creating passes in the normal 
way. 
 

 
 
The machining is then carried out with the tool axis rotated. That was already possible in previous versions. 
 

 
What is new now is that you can use a rotated boundary to limit the area, but keep the tool axis in Z. This is to 
be able to define an area by using a different view than the top view when creating the boundary. 
 
The procedure is the same. When creating the toolpath, the folder with the rotated boundary is selected. To 
keep the tool axis in the Z direction, go to the page Tool axis control in the 5 axis advanced pages. Klick on 
the button with the tree dots and select Top. The toolpath is then generated within the tilted boundary but the 
toolaxis remains in Z-direction. 
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The only difference in the settings to the toolpath in the image on the previous page is that Top has been 
selected, and the tool axis remains in the Z direction. Accordingly, no rotation is output to the NC program. 
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Release Notes for DEPOCAM v18.0.11          10th March 2022 
 
8170: Post Processors: The GPost-APT macro post processor did not honour the post processor settings 
Minimum and Maximum arc radius or the Minimum arc chord length setting when outputting circular 
moves. Under certain circumstances, this could lead to a full circle being output into the NC-Program instead 
of a circle segment. 
 
If you use a GPost post processor, we ask you to install version 18.0.11. 
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Release Notes for DEPOCAM v18.0.10         02nd March 2022 
 
8022: UI: Fixed an issue when inserting a database into another, which was setting the draw state of new plans 
incorrectly. 
 
8040: UI: Fixed an issue with the draw state of a folder not always being set correctly when the folder is deleted, 
if it had been used to create other folders. 
 
8059: Import: The Datakit libraries have been updated to 2022.1. This supports SOLIDWORKS 2022 and the 
latest NX version. 
 

 
 
8077: UI: The draw state of post-processor and toolsheet folders upon creation was previously set only if any 
of the input plans were set to drawn, this was changed in 18.0.08 but has now been fixed. This also fixes ticket 
8110. 
 
8082: UI: There were examples where changing the tool in the inputs page of a Five-Axis dialog would cause 
DEPOCAM to crash, this has now been fixed. 
 
8092: UI: Fixed an issue, where if a plan existed as an input to another plan and is unticked, but also in the 
recycle folder due to it being deleted from the top level. The plan could remain drawn when it should not be 
because items in the recycle folder are not drawable. Also added a fix for plans being replaced in collapsed 
folders. 
 
8093: UI: Fixed an issue with Parallel Pencil and Corner Offset Passes plans not being drawn upon creation. 
 
8114: UI: If you create a Tool in the Tool Folder with modified "Ramp Up" or "Rapid" feedrates, and used that 
tool to create passes, the "Ramp Up" or "Rapid" feedrates values would not be copied over correctly, this has 
now been fixed. 
 
8119: Linking: A performance issue with the linking of Waterline Stepover passes has been fixed. The linking 
has been speeded up for one example from over 24 hours to under 15 minutes. 
 
8122: Tool Database: There were occasions where creating a new dca file would result in DEPOCAM hanging. 
This was due to the Tool Database initialization. Which has now been fixed. 
 
8125: Transform: There were occasions where doing an edit transform and re-running dependent plans would 
cause DEPOCAM to crash if the ‘Repeat count’ was greater than 1, this has now been fixed. 
 
8151: Adaptive Clearance: The "DHC" (Dynamic Holder Collision avoidance) clearance parameters were not 
always being set correctly, this has now been fixed. 
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Release Notes for DEPOCAM v18.0.09     23th December 2021 
 
In v18.0.08 problems can arise when resetting parameters in the dialogs # 8054. We therefore recommend 
installing v18.0.09, where this has been fixed and a few other things. 
 
 
8021: UI: Modify Curves: We now only pop the bounding box dialog when modifying curves (and no boundary 
supplied) when rotation model isn't set if the input curves have a non-zero rotation. 
 
8034: UI: Fixed a crash that would occur when attempting to transform an edited boundary with a rotation 
 
8048: UI: Before 18.0.08 it was the case that if a plan label had been changed from the default then it would 
not be changed when re-running the plan, this was changed in 18.0.08 but has now been reverted. Also fixes 
#8041 and #8045. That means, the software behaves again as it did before v18.0.08. 
 
Explanation: It makes a difference whether a folder of an operation (plan) is created directly with a certain 
name, or whether the name is changed in the directory tree. If the name is changed in the directory tree, the 
operation will get the default name when it is re-run. If you give an operation a different name during creation, 
as shown in the figure below, the name will be retained when the operation is re-run. 
 
 

 
 
8049: UI: Fixed cutting parameters, tapefile and toolsheet plans not being created when transformed. Also fix 
boundary plans not being created when transformed with cutting parameters, tapefile or toolsheet plans. 
 
8054: UI: Fixed plan parameters not being reset when choosing "Reset to System Defaults" or pasting 
parameter values in the properties dialog. As a result of this problem, the dialog could show values different to 
what would be used. 
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Release Notes for DEPOCAM v18.0.08     10th December 2021 
 
 
Important 
 
7873: DEPOCAM will now only install on Windows 10 and onwards, operating systems. Attempting to install 
on older / unsupported Windows operating systems will give the following message. 
 

 
 
 
General 
 
4146: UI: Detect Holes: We now first try and get the preferred rotation model from the input boundaries folder, 
if there is one. 
 
6170: UI: "Draw Selected Items" and related options now work on all plans, not just root plans. Plans that are 
drawn but do not have their output drawn are now indicated by an indeterminate state  check box. 
 

 
 
The Draw Selected items options from the mouse right context sensitive menu. 
 

  

 
Initially nothing is drawn, no check box is ticked. 

 
The ‘Draw Selected Items Only’ was used on the 
‘Horizontal passes’, they get drawn and a tick in the 
check box, but the ‘Horizontal Area Toolpath’ gets a 
black square. This indicates it is not drawn, but 
something below it is. 
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6525: Tool Database: The "Ramp Up" and "Rapid" fields have been added to the Cutter > Advanced page for 
all cutter types, and their values are also stored in the tool database. 
 

 
 
6945: UI: It was possible for Drilling Data folders and Detect Holes plans to create folders with slightly different 
rotation labels based on the same holes. This has been fixed. 
 
7514: UI: Fixed an issue which could result in large parts getting clipped in the graphics view. Also fixes ticket: 
6901 
 
7733: UI: Added an option to only re-run plans in branches above selected plans to the plan properties dialog. 
The "Re-run dependent plans" tick-box has been changed to a drop-down to accommodate this new option. 
 

 
 
7776: Linking: The positioning of helical leads for Waterline Offset passes has been improved. 
 
7830: UI: It is now possible align the view (using Ctrl + Shift + X/Y/Z) from curves folder if it has a bounding 
box as input, in the same way is possible for machining passes / toolpaths. 
 
7883: Waterline Offset Passes: Fixed a problem which could cause the passes to fail. This also fixes ticket: 
7859. 
 
894: Selected Surface Waterline Passes: A problem has been solved where unwanted pass fragments could 
sometimes be created beyond extreme edges of the set of selected surfaces. 
 
7895: UI: Fixed an issue when plans in the contents tree were sometimes being rearranged when a group 
were moved in the tree,  i.e. Dragging an item from a folder to the top level.  

In the picture on the left the Raster Passes outlined 
in red are selected. If “Re-Run: Selected branch” is 
chosen, the Raster Passes are re-calculated and all 
the plans above up to the Post Processor. But the 
re-calculation is only performed in this branch. The 
Stock Model in the other branch is not re-created. 
This would be the case if “Re-Run: All dependant 
plans” is selected. Then every branch would be re-
calculated where the raster passes are included. 
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7896: Import: The Datakit libraries have been updated to 2021.4. Support Parasolid 3D Read: V34.0. Also 
fixes ticket: 7716. 
 

 
 
7899: UI: Tree items that are not explicitly selected are now highlighted with a slightly transparent colour. 
 
For the following two images, the ‘Tessellations’ is the folder that was selected, but also results in the 
‘Triangulated surfaces’ folder being highlighted too. 
 

 

 

In v18.0.07 and earlier, both folders use the same 
select colour. 

In v18.0.08, the ‘Tessellations’ folder that was 
selected is highlighted with the normal select colour. 
The ‘Triangulated surfaces’ which also needs to be 
highlighted uses slightly transparent version of the 
‘select colour’. 

 
7905: UI: Keep plans that are drawn and inputs to another plan, if they are deleted from the top level of the 
contents tree. 
In v18.0.07, the behavior would be: In v18.0.08, the behavior is: 

  

Item at the top level and in the history of another 
item. Selected at the top level and deleted. 
That was un-ticking it in the history. 

In v18.0.08, deleting the item at the top level of the 
tree, will not un-tick / erase the item in the history. 
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7907: Five-Axis: The "Point tool to rotary axis" option for 4-Axis machining has been added to the user 
interface, the default it is unticked. It was only accessible via the 5 axis console before, this just provides 
quicker / easier access. 
 

 
 
7910: Curves: The handling of the rotation model has been improved for the Curves plans and Along Curve 
machining. More effort is made to retain horizontal arcs when handling curves in rotated planes. Horizontal 
arcs can be fitted in rotated planes when thinning curves using the rotation associated with the input boundary 
plan. This requires the bounding box dialog to be displayed when editing the curves with the Break, Join, 
Extend… functions. Also fixes tickets: 7915 and 7926. 
 
7911: UI: Tool and hole-shape folders will now be copied to new graphics windows, like the Tool Folder is 
copied (they do not need to be selected). 
 

 
 
7912: UI: When selecting surfaces by layer or colour the resulting surfaces may now either be used for normal 
machining or for selected surface machining, using the new "For selected surface machining" switch. This will 
normally be turned on automatically when editing surfaces by colour, and otherwise turned off. 
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It is possible to access the switch after sorting by layer or colour via the folders properties. Also fixes ticket 
7906. 
 
7922: UI: The rotation model for a boundary is now preserved when editing. 
 
7925: Adaptive Clearance: It was possible when using the 'Min cut width' option for the toolpath to fail with an 
exception. This is now fixed. 
 
7930: Ruled Surfaces: A problem has been fixed where if a ruled surface was formed using two curves selected 
from a single tessellated curves plan, the data on the Inputs page of the ruled surface dialog would be 
unusable. 
Any macro generated from such a ruled surface plan would be unusable too. These macros should be 
recreated after re-loading the relevant original dca file into DEPOCAM. 
 
7932: UI: Fixed an issue with plans not being given new labels when being re-run. 
 
7935: Transform: Transforming a toolpath using a rotated Coordinate System will now try and get the preferred 
rotation model from the coordinate system rather than the toolpath. 
 
7937: UI: Fixed a problem with folders not being updated in a cloned or copied graphics windows. 
 
7939: UI: The selection box now has a transparent fill, the box outline is now drawn with a dashed line when 
dragging right-to-left. 
 

  

 
Selecting Left-to-Right. Solid line. Selecting Right-to-Left. Dashed line. 

 
7942: UI: Fixed a problem with the contents tree, with an inactive graphics windows not being updated. 
 
7943: UI: Fixed a crash that could occur when copying a graphics window whilst running a Cutter Animation. 
 
7944: Post Processors: ISO, Heidenhain and Siemens: Added the parameter "Text before a vertical toolpath 
following a rotated toolpath", which has no text by default. 
The option "Output rotation back to zero" must be set false for this to be activated, and the current toolpath 
needs to be 3+2 and the next toolpath vertical, or a tool change is required after a 3+2 toolpath. 
 

 
 
7957: Shaft Profile: An issue has been fixed which could lead to incorrect results in shaft profile calculations. 
Also fixes ticket: 6874 
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7963: UI: Waterline Stepover Passes. The smoothing page has been added to the dialog tree. 
 
7970: Stock Models were sometimes failing to accept cutting parameters as input. This has been fixed. 
 
7976: Rest Area Boundaries: Fixed a problem which was causing Rest Area Boundaries to fail if the Machining 
Passes were changed via the Inputs page in the dialog. 
 
7979: Installer: The option to choose the installed simulator language has been removed from the installer 
component options. More languages have been added for the simulator translations too. 
 

 
 
Files for each language option selected, are installed to the 'Simulator' directory in the install folder. The default 
Machine Simulator language is set by the language chosen in the first dialog of the installer. 
 

 
 
7998: UI: Drilling data folders are now visible (ticked) by default when it is created, in keeping with other items. 
 

 
 
8005: UI: Fixed an issue with plans being unticked when created by running a macro. Also fixed an issue 
where plans created by a macro were not being organised when 'Automatically organise tree view' is enabled. 
 
8007: Macros: Plans created by running a macro will now be drawn by default. 
 
8013: UI: The 3D Tool Guide was not displaying the tool correctly if thicknesses had been set differently for XY 
and Z  e.g. XY Thickness = 1.0 and Z Thickness = 0.5, this has now been fixed.  
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Release Notes for DEPOCAM v18.0.07   1st October 2021 
 
Just after the release of version 18.0.06 a problem with the compound cycles was discovered. That is why we 
immediately released version 18.0.07, in which this problem is fixed (7885). Therefore please consider the 
release notes for version 18.0.07 and 18.0.06. 
 
Important: 
We pointed out in the v17.0.07 release notes that the support for Windows 7 had ended in January (2020), 
and that while DEPOCAM was still installing and running on Windows 7, we did not know for how long. 
 
It appears that time has now arrived, some of the libraries that we use are no longer supported or function on 
operating systems older than Windows 10. To use DEPOCAM 18.0 you must have a Windows 10 operating 
system. 
 
 
1385: UI: Reduced shininess to make surfaces more visible when viewed head-on. 
 
 
Graphics in 18.0.06 and earlier 

 
 
Graphics in 18.0.07 

 
 
4353: Cycles: The Dwell option is now taken into account when Post Processing Emulated Drilling Cycles. 
 
7730: ModuleWorks: The ModuleWorks libraries have been updated to MW2021-08. 
 
7872: Along Curve Passes: It was possible to created corrupt curves if the rotation model used for curve 
extraction differed from the rotation model for the passes. This has now been fixed. 



 

 

 

 

Bgm.-Neumeyr-Str. 7 
85391 Allershausen 
Fon:   +49 8166 9982840 
Fax:   +49 8166 9982842 
Email: info@ncgraphics.de 
Internet: www.ncgraphics.de 

 

________________________________________________________________________________________________ 
DEPOCAM 18.0                                                          Page 17 of 74  

7878: UI: Fixed the tool folder not being updated when running a macro 
 
7885: Compound Cycles: Fixed a problem which prevented compound cycles written before 18.0.06 from 
loading into 18.0.06. Please note that compound cycles exported from 18.0.06 will not work. 
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Release Notes for DEPOCAM v18.0.06  17th September 2021 
 
While it is mainly little fixes in v18.0.06, there is an important ticket (7832) for arcs on a rotated plane if you 
machine in a 3+2 mode. There are some performance improvements for a couple of things too. 
 
4353: Cycles: The Dwell option is now taken into account when Post Processing Emulated Drilling Cycles. 
 
7705: Post processors: Heidenhain: Added two options to the Home Point section. Output uncompensated 
home point after rotation and After rotation: home point suffix. By default, Output uncompensated home 
point after rotation is set false so that existing post processors are not affected. If set true, it is then possible 
for the home point not to be output before the rotation, and then after the rotation the machine will move to the 
XY (Only) coordinates of the home point without any rotation compensation. The After rotation: home point 
suffix will also be added to the end of that block. Typically, this would be M130, and is only active for the block 
it is specified in. 
 
If using this feature, it would be safest to have a block like "LZ-1 FMAX M91" before any rotation, to retract the 
Z axis to the machines highest position. 
 
7785: Five-Axis: The Tool Axis Control parameter "Point Tool to rotary Axis" in the ModuleWorks 5 axis user 
interface is set to true by default if we are creating a 4 Axis toolpath. 

 
 
7793: UI: Fixed incorrect file name in the "Save changes" confirmation dialog. 
 
7794: UI: The dashed line to indicate the cutting direction / angle for the Raster, Perpendicular Raster dialogs 
was not being displayed, this has now been fixed.  
 
7796: UI: New images added to the dialog for Five-Axis Flank Machining Gouge protection options. 
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7804: UI: If a new folder was created, e.g. Editable Boundaries, it could not be deleted immediately. Another 
folder had to be selected before. Now the folder can be deleted directly after creation. 
 
7805: UI: Fixed the highlight colour of running plans sometimes not being updated in the tree view. 
 
7806: UI: Clicking the last selected folder in the directory tree with the Ctrl key pressed, the folder jumped into 
the renaming mode instead of being deselected, the folder is now deselected. 
 
7807: 3D Tool Guide: The orientation of the tool could sometimes be incorrect when the tool's axis was set 
using an edited boundary folder. This problem has now been fixed. 
 
7808: Cutter Simulation: If you are simulating multiple toolpaths and you change the feedrate slider position, 
that value will now be used for any remaining toolpaths selected, during the current simulation. 
 
7809: Extract curves: The performance of extract curves when used on larger parts has been improved. This 
improvement also comes into play when capping holes, because curves are extracted during the hole capping 
process. 
 
7810: Extract Curves: Fixed a problem which meant extract curves plans could not be cancelled during 
operation. 
 
7811: Cap holes: Curves are extracted from the holes in the process to cap them. The curve extraction dialog 
is now displayed before the dialog of capping holes. The curve extraction dialog can usually be confirmed with 
OK without any changes. However, it gives you the option to change settings. The tangent angle has now been 
changed from 10 to 30 degrees in the default settings, which means that smaller holes are capped more 
reliable. 
 
7812: Selected Surface Machining: The trimming boundary was not being respected for Raster, Perpendicular 
Raster, Radial or Spiral, this has now been fixed. 
 
7813: UI: When selecting a new Constraint Boundary on a plan Inputs page, it would not always trim the 
passes correctly, this has now been fixed. 
 
7815: UI: Fixed a case where changing the graphics background colour would cause the Wireframe HLR 
rendering mode to be incorrect. 
 
7816: UI: Improved performance when adding plans to a folder in the contents tree view, for example when 
many drilling data folders are created at the same time. 
 
7818: Points: The accuracy of points selected from the graphics view has been improved. For example, when 
the points are used to create a coordinate system, it has the desired accuracy now. 
 
7820: Cutter Simulation: If a simulation was run in multiple views DEPOCAM could crash, this has now been 
fixed. 
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7823: Canned Cycles: Bore Milling and Boring. The cutters default body length has been changed from 6 x 
shank diameter to 2 x shank diameter. 
 

 
 
7824: Linking: Waterline Offset Passes. We were sometimes failing to produce horizontal lead out arcs when 
linking edited Waterline Offset Passes, this has been improved. 
 
7825: UI: When changing the Grid Size for Boundary creation in the options dialog the value was not being 
updated correctly, this has now been fixed. 
 
Also, the positioning of the dialogs when doing an interactive tool definition has been improved. 
 

 
 
7826: UI: There was a problem when doing properties on a plan, that some of the controls / text fields in the 
dialog would not fit correctly, this has now been fixed (it only affected some none English languages). 
 
7828: Helical Passes: A problem which could lead to out of tolerance passes in internal corners resulting in a 
little bit of material being left on the part, has been fixed. 
 
7831: UI: When generating along curve passes, the direction arrows are now displayed again. 
 
7832: Post Processor: ISO: Heidenhain, Siemens, and GPost APT: There were occasions when the direction 
of an arc move was being output incorrectly for a 3+2 toolpath, if the A or B rotation was 90 degrees or more, 
this has now been fixed. 
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7837: Machine Along Curve Passes: DEPOCAM could crash when opening the Along curve Passes dialog 
with Ctrl options checked. This has been fixed. 
 
7838: UI: Fixed boundary plans being initially drawn at the wrong height. 
 
7840: UI: There were occasions where picking a small cutter size from the Most Recently Used tool list was 
causing DEPOCAM to crash, this has now been fixed. 
 
7843: Post Processors: Sometimes the Heidenhain Post output the toolname in the TOOLCALL statement 
even when it had not changed. This problem has now been fixed. 
 
7844: UI: There were occasions when toolpaths were not simulated in the order that they were selected in, 
this has now been fixed. 
 
7848: UI: Fixed any Tool plans that are included in a macro, not being added to the Tool Folder as the should 
be. 
 
7848: UI: If tools are selected in the tool folder when writing a macro, they are now written to the macro and 
generated in the tool folder when the macro is executed. 
 
If you only want to write tools and no machining operations in a macro in order to later read these tools into a 
database (.dca), proceed as follows: Select the desired tools in the tool folder and select File > Macro > Save 
as. When saving the macro, select the No dialogs and check the box next to Surface independent. If you 
later want to load the saved tools into another database, select the folder of the triangulated surfaces and 
execute the macro with File > Macro > Run. 
 
7852: Tool database: Using the same tool database with multiple instances of DEPOCAM could result in a 
crash, this has been fixed. 
 
7855: UI: Rest Finishing: The cutters Corner Radius is now greyed out, if the cutter / tool is selected from the 
tool folder. 
 
7860: Import: There were occasions when reading curves from an IGES file, and using the Convert to NURB 
option, not all curves would be read. This has now been fixed. 
 
7863: Tool Database: There were occasions when the preview image in the cutter tab was incorrect if a 
thickness had been set, this has now been fixed. 
 
7867: Cutter Simulation: The correct default stock size was not being created for Split or Sister Toolpaths, this 
has now been fixed. 
 
7875: UI: Using the Q key to select only the elements in the foreground when selecting with a box could cause 
the software to crash. That has now been fixed. 
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Release Notes for DEPOCAM v18.0.05    28th July 2021 
 
7706: Post processor: ISO: If the "Output true rapids" option was set 'false', it was still possible for a G0 (rapid) 
to be output at the very start of the NC file. It was also possible to get a G0 on the approach to a hole for 
drilling. Either could then also result in the rapid feedrate not being output. These have now been fixed. (Also 
fixes ticket 6317). 
 
7711: 3D Tool Guide: Using the Ctrl + arrow-key to move the tool across the part now respect the tool axis of 
the selected boundary. 
 
7713: Export: A problem which meant writing STL files in parallel could create corrupt files has been fixed. 
 
7717: Import: Fixed a failure that could occur when loading some IGES files. 
 
7725: UI: There was a problem when doing a properties on a plan dialog, that it was clipping the edge of the 
dialog making it slightly smaller than required, this has now been fixed. 
 
7728: Import: The Datakit libraries have been updated to 2021.3. 
 
7740: UI: Made the selection box more visible on grey backgrounds. 
 
7741: UI: Added the Ctrl option to the ‘Create coordinate system’ so it is more consistent with other functions. 
 

 
Can now be picked with Ctrl to 
get the Control options.  

 
7752: Post Processor: ISO, Heidenhain and Siemens: Fixed a problem when working in 3+2 which could lead 
to the output of unwanted vertical arcs for lead in/out moves when the “Output circular arc records on rotated 
planes” was set ‘true’. 
 
7777: UI: Restored selection performance for Nvidia Quadro series GPUs, and added an option to the Graphics 
options page to disable the selection acceleration, added in DEPOCAM v18.0.04 which caused an issue in 
some cases. This option should be left un-ticked unless there has been a noticeable reduction in selection 
performance since DEPOCAM v18.0.04. 
 

 
 
  



 

 

 

 

Bgm.-Neumeyr-Str. 7 
85391 Allershausen 
Fon:   +49 8166 9982840 
Fax:   +49 8166 9982842 
Email: info@ncgraphics.de 
Internet: www.ncgraphics.de 

 

________________________________________________________________________________________________ 
DEPOCAM 18.0                                                          Page 23 of 74  

7779: Import: Updated Granite to v14.0.1. 
 

 
 
7780: UI: Moved the "Show rendering time on the status bar" option from the Graphics page to the Preferences 
page. 
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Release Notes for DEPOCAM v18.0.04   05th July 2021 
 
While mainly enhancements to v18.0.03, there is also a couple of new features in the select box and the option 
to use multiple boundary folders when defining the passes. 
 
 
New features 
 
6548: Selection: If the Select box is dragged from left to right, only the items that are completely within the box 
will be selected. If the box is dragged from right to left, any items that are completely and partly in the box are 
selected. 
 
Mini guide 

 

 
The triangulated surface folder is selected. 
 
A select box is created from Right (1st) to Left (2nd). The top 
to bottom does not matter, it is the Right to Left that is 
important. 
 
Selecting in this Right to Left direction, any surface the box 
cuts through will be selected. 

 

 
After releasing the mouse at the 2nd position, it will select 
the surfaces the box cut through. 
 
Note: Image left. While not visible in that image, the parts 
bottom/hidden surfaces will also be selected. 

 

 
This time, creating a similar size box in a similar position, 
only this time then box is created Left (1st mouse click) to 
Right (2nd mouse click). 
 
Again the bottom to top does not matter, it is the Left to 
Right that is important. 
 
When selecting in the Left to Right manner, only surface 
totally within the box will be selected. 
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In the image left, we can see no surface are selected, as 
the select box and the Left to Right method did not totally 
enclose any surface. 

 

 
This time the select box is bigger but is still created from 
Left to Right. 
 
The select box encloses the purple corner fillet surface this 
time. 

 

 
After releasing the mouse, any surface(s) that were wholly 
within the select box are selected. 
 
That purple corner fillet is selected, but the surfaces around 
it are not, despite the select box being partly over them, that 
is because they were not wholly within the select box. 
 
 
 
While surface have been used for this example, the same 
rules apply for Boundaries, Curves, Points, Passes… 

  
7643: UI: Machine along curve passes can now be run with multiple curves plans (folders). 
 
7655: UI: Raster Passes and Perpendicular Raster Passes Plans have been modified to accept multiple 
constraint boundary plans as an input. 
 
7674: UI: Modified Area Clearance, Core Roughing, Horizontal area, and Core horizontal area plans to accept 
multiple constraint boundaries as an input. 
 
7676: UI: Waterline, Waterline Offset and Waterline Stepover passes plans have been modified to accept 
multiple boundary plans as an input. 
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7678: UI: Radial and Spiral passes plans have been converted to accept multiple input boundary plans. 
 
7679: UI: Rest finishing passes have been converted to accept multiple boundary plans as an input. 
 
7680: UI: Pencil Passes, Parallel Pencil Passes and Corner Offset Passes have been modified to allow multiple 
boundaries as an input. 
 
Mini guide 
This example shows horizontal area passes, but the principal is the same for most other types of 
passes.(See the tickets: 7643, 7655, 7674, 7676, 7678, 7679, 7680 above) 
 
There are some exceptions like Helical passes and Morphed passes. 
Create any boundaries that will be required first, they can also have different tool axis. 

 

 
Here there are two boundaries with 
rotations, and a third boundary that is 
in the XY plane. 

 

 
Select the Triangulated surfaces, and 
the boundary folders. 

 

 
Pick the type of passes to create 
(Horizontal Area passes for this 
example) from the Passes Ribbon. 

 

 
The passes will be created for each 
boundary, for this example three 
boundaries were used, so three 
Passes folders were created in the 
contents tree.  

This can save time where the same type of passes is required in multiple positions with different tool axis. 
 
 
General 
 
6938: UI: Fixed an issue in the main title text that could sometimes result in the text not being displayed 
correctly. 
 
7433: ModuleWorks: Update to MW2021-04 libraries, and now enabling coloured output of Multi-Axis Stock 
Models, (ticket 2093). The default resolution of stock models has been changed to improve accuracy. 
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A stock model from one vertical area clearance toolpath. two 3+2 horizontal area toolpaths, and two 3+2 area 
clearance toolpaths for the 5 and 7 details. 
 
7449: UI: Improvements have been made to handling of a sub-selection of entities from a plan. If the user has 
selected all sub-items of geometry in a folder, we will try to avoid creating an unnecessary new meta plan and 
instead use the original plan. The handling of editable plans has also been simplified. 
 
7460: UI: It is now possible to calculate the bounding box of drilling data points. This also fixes ticket 7473. 
 
7548: Import: There were occasions when loading a Creo part which had surfaces with multiple outer 
boundaries, the trimmed surfaces could be incorrectly (keeping surfaces where they should be omitted), this 
has been fixed. Also fixes ticket 3084. 
 
7550: UI: Added an option to the tree view context menu to expand or collapse selected items, or all root items 
if none are selected. 
 
The Expand option in context sensitive menu. The Collapse option in context sensitive menu. 

  
 
Depending on the folder(s) being in a expanded or collapsed state, will alter the button in the context 
sensitive menu. 
 
If you have a folder or group of folders selected, only those folders will be expanded or collapsed. If no 
folders are selected, all folders will be expanded or collapsed. 
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7568: Toolsheets: There was not an option for the toolpath comment to be a single line of text, or to respect 
the multi-line text as entered. The new toolsheet option: "Respect new lines in toolpath comments" is set false 
by default, so toolsheets will appear as they did before, unless the option is set true. 
 

 
 
Also, historically to create multi line text in the cutting parameters dialog, Ctrl+CR (Enter) would be required, it 
now possible to use CR (Enter), without the need for Ctrl which is more logical, and in keeping with the project 
settings dialog. 
 
7586: UI: There were occasions when a cutters valid overall length parameter on the tool page would fail the 
dialog validation, this has now been fixed. 
 
7596: Rotations: Added a warning message that is displayed if drive boundary and constraint boundary do not 
have the same rotation when creating a Boundary Passes Plan. 
 
7597: UI: Fixed an issue with the axis letters not being displayed when the view is copied. 
 
7603: Import: There were occasions when loading an IGES file that surfaces could be loaded more than once, 
creating duplicates, this has now been fixed. 
 
7610: Drilling: There were occasions when creating drilling cycles that a warning would appear and say the 
drill was going to gouge when it was not, this has now been fixed. 
 
7625: UI: The cycle dialogs are now consistent in their use of the Shank Diameter parameter so that we are 
able to enable/disable the Shank Diameter control correctly. Before it appeared as if the shank diameter could 
be set when it could not. 
 
7634: UI: Blocked the running of a shaft profile analysis directly on another shaft profile analysis plan. 
 
7636: UI: The size of the tool rotation and RGB fields in the status bar have been increased. 
 

 
For these to be visible, they do need to be enables 
in the Preferences. 

 
 
7641: Ruled Surfaces: It is now possible to create a ruled surface by selecting two curves from within a single 
plan.  
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In v18.0.03 where the feature was introduced, each curve had to be in its own folder, the two curves can now 
be in the same folder. Select the relevant two curves (and optionally the triangulated surface folder), then a 
ruled surface can be created between the two curves. See image in ticket 7681 
 
7648: UI: Add dialog images for Pass Extension and Spindle Speed/Direction. 
 

 

 
 
7652: UI: It was possible for the view to be lost when scrolling, this has been fixed. 
 
7653: UI: The Tool database option was not being displayed correctly when opened from the Tool Folder 
context menu, this has now been fixed. 
 
7661: UI: Fixed an issue deleting hole shapes from the hole shapes folder, as it was not working correctly, 
delete needed to be pressed twice sometimes. 
 
7666: UI: There were occasions when the View ribbon was not being refreshed correctly after a View 
Parameter Space operation, this has now been fixed. 
 
7681: UI: The "Ruled Surface" option has been added to the Curves context menu. 
 

 
 
7683: Stock Models: There were examples where creating a Stock Model from a large number of toolpaths 
would fail, this has now been fixed. 
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7684: Linking: Helical Machining. The default ramping options for helical toolpaths was "Profile ramping" and 
the ramp angle was inherited from the passes. The default ramping style is now "Helix ramping" and the ramp 
angle has been set to 10 degrees. 
 

 

 
Above: Helical ramping, 10° ramping 
angle. (v18.0.04 defaults) 
 
Below: Profile ramping, 2° ramping 
angle. (v18.0.03 defaults) 

 
 
7685: UI: Fixed an issue with Transformed surfaces not always being selectable. 
 
7689: UI: Added the modification state of the active database to the main window title, and fixed a case where 
the title wasn't updated correctly. 
 
7694: UI: There was a problem when using a tool from Recent tool list and editing the parameters causing the 
Shaft Profile parameters to be incorrect, this has now been fixed. 
 
7695: UI: It is now possible to copy and paste tool parameters into Passes plan dialogs from dialogs which are 
not Passes plans. Also fixes ticket 5267. 
 
For example, copying the cutter details from the Theoretical rest areas cutter page, can now be copied, and 
then pasted into the cutter page of waterline or raster passes. 
 
7699: UI: The Detect Holes icon on the ribbon interface has been improved to give a better contrast between 
the Active and Inactive states. 
 

 
 
7700: UI: Convert To Boundary will now respect sub-selections as available within the User Interface. Currently 
this allows sub-selection from plans of different types (for example Boundary type, Passes type, curve type), 
but not sub-selection from plans of the same type. 
 
7701: UI: When taking a mouse hit from the screen to transfer to a dialog field (clicking on a surface, to populate 
the Z min field for some passes for example), we now set the number of decimal places correctly. 
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7707: Import: Updated Granite to v14.0.0.0. This provides support for Creo 8.0 files. 

 
 
7714: UI: When holding the Shift key while invoking the Linking dialog the "Preserve root folders" option was 
not ticked when it should be, this has now been fixed. 
 
7720: Linking: Helical machining with helical ramp moves could result in a disjoint in the toolpath. This has 
now been fixed. 
 
7722: UI: The "Background Colour" sub-menu on the context menu has been moved to be below the "Draw" 
sub-menu. This ensures the context menu fits onto standard sized screens when selecting surfaces. 
 

 
 
7723: UI: When loading a tool from the Recent Tool list and then updating some tool parameters, the tool/cutter 
name was not being updated correctly, this has now been fixed. 
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Release Notes for DEPOCAM v18.0.0 to 18.0.03 27th May 2021 

 

There are several new features along with many smaller features, and improvements, plus many other general 
fixes and updates. As a major release, you will require a new licence code. The new features have been listed 
first; then the equally important enhancements and fixed tickets, after that, you will find the tickets are generally 
in numerical order. 
 
 
New Features. 
 
Axial offset for waterline passes. 
2537: Waterline Offset Machining: A new semi-finishing machining strategy. Additional, simple, XY offsets can 
be specified in addition to a Waterline style finishing pass to aid in the machining of steep and thin wall sections 
with small amounts of residual stock. The minimum number of offsets permitted is one. This also fixes tickets 
1311 and 6950. 
 
Mini guide 

   

The part with a thin wall (rib) section has 
been roughed out +3mm in XY, but just 
0.2 in Z. 
 
Here the part is on the left and a stock 
model of the roughing on the right. 
It is from this point that Waterline offset 
passes can be used to finish the part. 

 

 

 

 
There is a new Ribbon button and option 
in the mouse right context sensitive 
menu. 

 

At first glance it may look like the 
Waterline passes dialog, but there are a 
couple of extra options. 
 
The Offset distance can be set, and the 
Number of offsets can be set. 
 
One multiplied by the other will define 
the width covered. 
In this example / guide there is 3mm left 
on, so if the offset (stepover) is 0.5, then 
5 passes are required. 
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Linking is much the same as 
conventional waterline linking. 
 
The outer most pass for the first level is 
the starting point for the machining, at 
that first level it will then work into the 
part. 
Then a step down to the next level and 
repeat the process. 
 
It gives the potential to finish a tall, thin 
wall or rib, while maintaining some 
strength in the stock material below the 
area being machined. 

 
 
Creation of a revolved surface from a curve. 
3876: Add revolved surface: Using a selected curve as the spine and using the datum point's axis as the 
rotation direction, at a given rotation angle, the curve swept around the given rotation direction to create the 
revolved surface. Updated the documentation. 
 

 
 
Mini guide 
 
Create a coordinate system, this will give a 
position and vector for the revolved surface. 
 
 
For this example, it is just a simple 30 
degrees of rotation around the Z axis. 
 
The X axis of the new coordinate system will 
be the axis the revolved surface is created 
around. 

 
 
The curve can be extracted from a surface or 
be a boundary that is converted to a curve, or 
a curve imported with the model. 
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With the Coordinate system and the curve 
folders selected, Revolved surface can then 
be picked for the Geometry ribbon. 

 

 
When creating the revolved surface, it is 
possible to set a start and end angle. 
 
Here it is being created between 0 and 270 
degrees. 
 
The X axis has been selected as the axis of 
the selected coordinate system to revolve the 
curve around. 
 
The surface will use the ‘Default entity colour’ 
(as set in the system colours), but the option 
is there to make the surface the same colour 
as the curve. 

 
 
This is the result, you can see how the curve 
has been revolved around the coordinates 
systems X axis, but only for 270 degrees. 

 
 
 
Snapping grid for boundary creation. 
4644: Boundaries: New options have been added to the User Interface to display (and snap to) a grid when 
creating a boundary, arcs are also supported (by using the Shift key). This can make drawing freehand 
boundaries with ‘square’ edges and to a known size easier and quicker. 
 
Mini guide 
The grid size can be set via:  Options > Graphics 
The default size is 10 

 
The grids display can be toggled on and off as can 
the snapping.  
The grid is only displayed when in boundary edit 
mode is active. 
 
The grid can be displayed without the snapping, but 
if the snapping is enabled, but the grid is not 
displayed, it will not snap. 
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It is also possible to modify the grid size from the 
ribbon. 
 
A boundary being created using the snapping grid. 

 
 
Selected surface machining based on the surfaces colour. 
6869: Selected surface machining: Machining on a select plan (the outputs of Edit > Folder by Colour) now 
works in the same manner as selected surface machining. That is the surfaces in the plan are machined with 
the plan's input as protected surfaces. This allows macros to be created with selected surface machining 
specified by colour. This also fixes ticket 2868. 
 
The surfaces need a colour scheme for this to work, it is important to understand that it uses the Red Green 
and Blue values of the colour. 
 
 

The colour graphically The RGB values While the two green coloured panels may look the same on 
the screen, they are different. DEPOCAM considers the RGB 
values. 

 0  255  0 

 0  253  0 

 
Mini guide 
Using boundaries method.  
 
First part / macro creation   

This example will create passes for the orange and 
yellow surfaces. The macro can then be used on a 
different part. 

 
The model is ‘colour coded’ and can be done in 
the CAD system or in DEPOCAM 
 
If setting the surfaces colour in DEPOCAM, 
select the surface(s), then pick:  Edit > Colour 
Select Custom, and click on the coloured panel. 
If you then click on the Define custom colours >> 
button, you can see the RGB values. 

 
With the triangulated surfaces selected, pick: Edit 
> Folders by colour 
That will create a triangulated surface folder for 
each surface colour based on the RGB values 
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Select the triangulated surfaces for the orange 
surfaces and create a boundary. 
 
Here you can see the triangulated surfaces folder 
used and the resulting boundaries. 

 
Select the triangulated surface for the whole part, 
and the required boundary folder, then create the 
required passes. 
 
Here horizontal area passes have been created, 
then items ticked are the items used and created 
for this step. 
 
The passes were then linked. 

 
 
Select the triangulated surfaces for the yellow 
surfaces and create a boundary. 

 
Using the triangulated surface for the whole part 
and the boundary folder from the yellow surfaces, 
the passes can be created and linked. 
 
Clearly more toolpaths can be created for other 
areas. 

 
 
Creating the macro 

 

Select the surfaces, boundaries, and toolpaths to 
be saved to a macro. 

Pick: Application button  > Macros > Save as 
 
You are unlikely to want the file open dialogs, or 
to be prompted with the project settings. The Use 
input geometry will want to be selected. 
Give a suitable file name and save the macro. 

 

Running the macro on another part  
Open another part. 
It may have the correct colour scheme, or it may 
require the colours to be changed. 
 
Just remember the surfaces colour must have the 
same RGB values as the macro. 
The fact that it ‘looks about the same colour’ is 
not going to work correctly. 
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With the Triangulated surfaces folder selected, 

pick: Application button  > Macros > Run 
Browse and select the relevant macro, then Open 

 
The macro will create the boundaries from 
surface of the same colour as the macro was 
created. 

 
Selected surface method  
 
First part / macro creation   

With this example we will create passes for the yellow 
surfaces (as selected surface machining). The macro 
can then be used on a different part that has surfaces of 
the same colour. 

 
As with the previous example, the part needs to 
have the surfaces separated by folders of colour. 
 
Select the Triangulated surfaces folder, then pick 
Edit > Folder by colour 

 
Select the Colour RGB 255 255 0 Triangulated 
Surfaces folder (this is just the yellow surfaces). 
Pick Raster passes (Waterline, Helical, Spiral, 
Radial could also be used). 
 
Then link the passes, cutting parameters to if you 
want. 

 
 
Creating the macro 

 

Select the surfaces, boundaries, and toolpaths to 
be saved to a macro. 

Pick: Application button  > Macros > Save as 
 
You are unlikely to want the file open dialogs, or 
to be prompted with the project settings. The Use 
input geometry will want to be selected. 
Give a suitable file name and save the macro. 
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Running the macro on another part  
 
Open a different part, as before the surface 
colours must be identical. 
 
Select the triangulated surfaces folder. 

 

Pick: Application button  > Macros > Run 
 
Browse and select the macro, then click Open 

 
The macro will run, and will separate the Folders 
by colour, this uses the yellow surfaces to create 
the passes, as selected surface machining. 

 
 
Organize folder by type in the contents tree. 
6513, 7471: UI: Added an option in the context menu to organise plans into folders corresponding to the plan 
type. 
 
There is also an option on the Preferences page to automatically organise plans as they are created, including 
opening a part file.  Note: if this is enabled, opening a dca file that did not have organised plans, will have 
them automatically organised as the file opens. If using the Organise folders, then the folder name is bold, 
just to make it stand out better. It is possible to drag item(s) from a folder back to the top-level using Shift + 
mouse left, or delete items from a folder. If everything is removed from a folder, the folder will be removed 
automatically. If you delete a folder there is a warning to say it is a folder and asks if you are sure. 
 
Mini guide 

 

Selective method. 
 
Select the items, then mouse right (in the 
graphics area), and pick: Organise 

 

This will create a folder for the item type, and 
then move the selected items to that folder. 
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After creating some more boundaries, passes, 
toolpaths etc, picking Organise again will move 
those items to the relevant folders 

 If nothing is selected in the contents tree, picking 
Organise, will organise everything that has not 
been organised. 
 

 

 
 
 

Automatic / global method. 
 
In Options > Preferences, there is the option: 
Automatically organise tree view. 
By default, this is not enabled (ticked). 
 
If enabled, as items are created, they will 
automatically be moved to the relevant folder. 
For example: Surfaces, Boundaries, Toolpaths, 
Five-Axis toolpaths, Stock models etc. 
 

 
 
3D Tool guide. 
6514, 7362 and 7428: 3D Tool guide: Added an ability to draw tools from the selected tool definition in the tool 
folder. If a surfaces folder is selected, then gouge checking for collisions will also be done. Movement of the 
3D tool guide now increases as the arrow keys are held down allowing for a better user experience. 
 
Mini guide 

 
The tool needs to be defined in the Tool Folder. 

 

With the required tool and triangulated surfaces 
selected. 
 
Optionally a boundary can be selected, if the 
boundary has a rotation, this will be used as the 
tool axis for the tool 
 
Selecting Tool and surfaces will allow the tool to 
be gouge checked. 
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From the View ribbon, it now possible to select 3D 
Tool Guide. 
Or it can be selected from the mouse right context 
sensitive menu, if you prefer that method. 

 

When the 3D tool guide is invoked, a dialog will 
appear. 
There is some basic information as to which cutter 
and holder is in use, and which surfaces are in 
use, along with any rotation / tool axis details. 
 
The gouge avoidance can be disabled/enabled by 
clicking on On/Off. 
 
While the gouge avoidance is enabled, using 
Ctrl + arrow key, the cutter will track over the 
surfaces, and highlight the holder if it collides. 
If disabled, the cutter and holder will not respect 
the surfaces. 
 
It is possible to give XYZ coordinates and then use 
the Apply button to move the cutter to that 
position. 
 
 

 

Place the cursor on the surface where you want to 
position / place the tool, then double click mouse 
left. 
 
In the image left, then tool has been placed on the 
surface at the bottom of the cavity. 
The holder is the ‘normal’ blue colour, so this is 
safe. 
 
It is possible to modify the position of the tool in 
small increments by: 
Ctrl + Up, down, left, or right arrow clicks on the 
keyboard. 
If an arrow key is held down, the tool will keep 
moving across the part. 
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In this image, the tool was moved across the part 
using Ctrl + up arrow to demonstrate a collision 
between the holder the part. 
 
If the holder collides with the part, it will be shown 
in red “(the Shaft profile (gouges)” set in the 
System colours) to indicate the collision condition. 
 
As the tool was moved across the part with Ctrl + 
up arrow clicks, the cutter tracked on the surface, 
following the surfaces shape, moving along the 
tool axis. 

In this image, a boundary with a B-10 C90 has 
been selected along with the Tool and Surfaces. 
The tool axis for the cutter is tilted over at 10 
degrees. 
 
It is possible to change the boundary selection in 
the contents tree, and then click somewhere else 
on the part and the tool axis will change. 

 

 
If no surfaces are selected, or the gouge 
avoidance is disabled the 3D tool can still be 
displayed, but it is not collision checked. 
 
Using the Ctrl + up, down, left or right will move 
the cutter in X/Y but it will not track Z on the 
surfaces 

 
There is the option for the 3D Tool guide, gouge condition colour to be user defined in the System colours. 
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Ruled surface. 
7114: UI: A new option for a ruled surface between two curves has been added to the Geometry ribbon. Also 
fixes ticket 2598 
 
Mini guide 

 

 
The hole needs to be patched over to aid 
machining 

 

 
Select the surfaces that will allow a curve to 
be created at one side. 
 
In most cases, if not all, you will not want all 
the curves, so not joining them makes 
sense, it will be easier to delete the 
unwanted bits of curve. 

 

 
The curves need to be edited so there is only 
the required part, it also need to be a single 
curve. 

 

Curves need to be created for the other side. 

 

Creating the ruled surface. 
 
Select the two triangulated curves folders. 
Then pick Ruled surface from the Geometry 
ribbon. Or Ruled surface can be selected 
from the mouse right context sensitive menu 
if you prefer. 
This will create a new folder with just the 
ruled surface. 
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Revolved stock model. 
7346 / 6939: Revolved Stock Model: Added the ability to create a revolved stock model. The Control Key may 
be used to get the Boundary creation dialog up to any able any rotations to be set. This controls the axis of the 
revolved prismatic stock model. Updated the documentation. 
 

 
 
Mini guide 
 
Create a points folder, and then 
a define a point. 
 
The point represents the centre 
of the diameter / Revolved stock 
model. 

 
In this example the revolved 
stock will run along the X axis. 

 
The view was changed to look along the X axis (the 
direction required for the revolved l stock), It will also 
help for the next steps. 
 
With the triangulated surfaces and point selected, 
Revolved Stock model can be selected from the 
Geometry ribbon while pressing Ctrl.  

Because Ctrl was pressed, the Control options are 
displayed. As the view was changes to look along the 
axis we want the revolved tock model will point, ‘Apply 
current view rotation’ can be selected. 

 
That will give the Bounding box dialog. 
All the parameters should be OK 
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The required diameter will need to be set. 
 
If the part was selected with the point to create the 
revolved stock model, the Z limits will be based on the 
triangulated surfaces.  
 

 

 
The Cylindrical Stock will now 
exist and can be used like any 
other stock model. 
 
 
 
 
 

 
 
 
Post processing as master and sub programs. 
5528 and 7313: Post Processing: It is now possible to create a master tape file which contains sub-programs 
(tape files) within it. This can be created at the time of Post Processing or as an extra step using the "Post 
Processor Master" option on the toolpath ribbon. The Tape file and sub tape file numbering options (delimiter 
and length) are provided in the post processor options. The tape file and tool sheet prefixes can also now be 
specified separate to the project prefix. 
 
Mini guide 

 

When post processing with a master 
file, the pre-existing “Post to individual 
file” needs to be enabled, before the 
new ‘Create master’ option can be 
used. 
The name of the master file is shown 
just below that option. 
 
The master file, will ‘call’ the individual 
files in the order they were selected for 
post processing. 
 
The option to ‘Group adjacent tools’ 
may also need to be considered. 
 

 

In the contents tree, the master file will 
be shown, and the individual files are 
listed as sub folders of the master.  
They are listed in the order they will be 
‘called’ by the master. 
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There are options within the post 
processor to allow control of the 
delimitator between the main name and 
sub-program number. (image left). 
 
(The delimitator between the main 
name and sub-program number is 
highlighted in circle in the image above). 
 
It is also possible to control the number 
of characters in the numbering, for the 
master program and the sub programs. 

 

The master post processor can be 
configured in a similar manner to the 
main post processor and be saved as a 
unique name. That name needs to be 
defined in the main post processor 
 
Potentially you may have several 
master files if you have several different 
machine controls 

 

The main post processor needs to know 
the name of the master post processor 
that is to be used. 

 

 
The additional file Prefixes for the Tape 
file and the toolsheet have also been 
added to the Project Setting dialog. 
 
By default the will be the same as the 
main Prefix 
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Cutter and Holder design sketch. 
7416: A new option "Design" has been added to the Cutter & Holder pages which displays a new window that 
will be used to create a profile and then it be imported as a shank or holder definition to the Cutter or Holder 
page. The “Design” option is not available for drill, reamers, taps, boring bars. 
 
Mini guide 

  
 
The Design button on the Cutter and Holder pages, (it is not on the Tool page). 
 

 

 
Irrespective of it being the 
Cutter page or the Holder 
page, when you click on the 
Design button, the window 
shown left will appear. 
It is here when you can draw 
/ design the cutter or holder. 
 
For clarity, the dialog with the 
Design button has been 
moved to one side and is not 
shown in this image. 

 

Designing a holder or cutter body, it is much the same as drawing a boundary. M may be used to Maximize 
the view, the roller wheel will zoom, and you can pan around with Shift + mouse centre. X,Y and Z work to 
for selecting a view, although Z is the intended view. 
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Designing the holder.  
 On the Holder page, click on the ‘Design’ button. 

 

The ‘Boundary editor’, ‘Display grid’ and ‘Snap to 
grid’ should be selected / enabled automatically. 
 
The grid size can also be set or adjusted as needed.  
 
Note: It is not possible to change the grid size once 
you have started designing the cutter or holder 
profile. 

 

 
Double mouse left to start the boundary, then 
additional mouse left clicks for direction changes. 
 
Once the boundary has been created, it is possible 
to move nodes around just like you can for a 
boundary. 
It is not possible to define an arc in a holder 
boundary, and this must be a single boundary. 
 
The space bar will terminate the boundary and leave 
it open.  
It is important that the boundary is left open. 
 

 

Once the boundary has been terminated, the ‘Import 
to tool definition’ button will be available. 
 
When you click on the ‘Import to tool definition’ the 
data from the profile will be transferred to the holder 
dialog. 
 
If there is more than one boundary, the ‘Import to 
tool definition’ button will not be available. 

 

 
The tool holder will now be visible in the Tool dialog. 
 
Then you can save it to a Tool Database, although 
you will need to give it a name first. Or continue 
setting other parameters for the passes, and click 
OK 
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Designing the cutter. 

 

 
On the Cutter page, set the basic cutter details, 
diameter, corner radius, taper, flute length, body 
length and then click on the ‘Design’ button. 

 

The cutter design window will appear, as with the 
holder design, expect the grid to be displayed and 
the snapping active.  
If needed the grid size may be adjusted. 
 
The cutters flutes will be shown rendered, and body 
length will be shown as a boundary. 

 

Make a double mouse left click near (but not on) the 
top of the body length from the initial cutter 
definition. 
 
Then make additional mouse hits to define the 
shape of the cutters shank. 
 
Press the space bar to terminate the boundary. (Has 
not yet been done in the image to the left). 
 
The start of the boundary you have just created now 
needs to be dragged onto the initial boundary from 
the original cutter definition with mouse left. 
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You should have a single boundary. 
 
If you have multiple boundaries, it will not be 
possible to do the next step. 

 

Clicking on the ‘Import to Tool Definition’ will transfer 
the shape to cutter page and close the Tool 
Definition window. 

 

 
The cutters shank profile on the Cutter page 

Once the cutter or holder has been imported to the cutter or holder page, any values can be modified if 
neded. 
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General enhancements and maintenance fixes. 
 
558: UI: Add the ability to include images in dialogs, currently we have images in the Tool/Cutter pages, 
Boundary plans, Axial Offset plan, Along Curve plan, Extract Slice Curves plan, Edit Transform plan, Cycles 
plans , Options > Axes, Animation pages, Revolved, Z-Trim Stock Model plans, Point Circle, Shaft Profile 
Analysis, Raster Linking plan, Five-Axis Along Curve and Flank Machining. These are just to help show what 
a particular parameter is for. 
 
3248: Import: The surface colours are now loaded correctly from Creo files. 
 
3268: Import: Fixed a problem where imported curves were not visible. 
 

  
The bounding box dialog. Raster passes, passes page. 

 
3331: Post processor: Heidenhain, ISO, Siemens: GPost: It is now possible to output arcs on rotated planes 
(3+2 machining). There is a new post processor option “Output circular arc records on rotated planes”. By 
default this is set false, so not to affect existing post processors, to have arc output for 3+2 machining it will 
need to be set true. Also fixes ticket 2353 
 
On a Hedenhain CYCL DEF 19.0 /19.1 or PLANE SPATICAL, a Siemens would need to be using CYCLE 800, 
and an ISO control what is normally G68.2 would need to be used, these are commands where the axis is 
rotated within the control, often referred to as a Rotated or Tilted working plane. If you use this please check 
the output for your machine before using on a real job. 
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3875: Stock Models: It is now possible to Union, Intersect, Subtract and Z Trim stock models. Updated the 
documentation. 
 

  
For a Union, Intersect, Subtract two stock 
model folders need to be selected. 
 

Trimming the stock model to a Z height 

4401: Selected Surface Machining: Some examples of creating Raster passes with a tool holder defined took 
over 10 times longer than without a tool holder, this has now been fixed. 
 
4863: Database: If "Start Macros Paused" is set, then any cancelled plans are paused when opening a 
database. This allows the user time to interrogate the plans before deciding which ones to run and which to 
delete. 
 
5532: UI: Removed the "Contact areas only" option from the stock model dialog and from the documentation 
as it had no effect. The effect is achieved by setting the flag on the underlying passes. 
 
6005, 7090: Import / UI: When loading the model, empty surface, curve or point folders are no longer created. 
Irrespective of component information being enabled or not. 
This keeps the contents tree tidy. 
 

 
 
6057: Stock Models: It is now possible to transform stock models, (this does not include the open stock models 
created from 3 & 3+2 axis toolpaths). Updated the documentation. 
 
6115: User Interface / Printing: Fixed the printing 1:1 scale mode. 
 
6122: Post Processors: The GPost macro was not always calculating the Block extents for Five Axis 
Conversion toolpaths correctly, this has now been fixed. 
 
6123: UI: Change the material cutting speed units from mm/min, inch/min to m/min and ft/min. These changes 
will affect the material library, project setting and cutter advanced pages. 
 

 
This should not affect any existing material database, as it is only how the value is displayed in the dialog. 
 
6217: Inspection: A problem has been fixed where valid inspection vectors could not be placed due to wrongly 
detected collisions between the holder and part. 
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6326: Five Axis: There were occasions when changing the gouge tilt strategy on the ModuleWorks advance 
page would cause a crash when the plan was run, this has now been fixed. 
 
6402: Cutter Simulation: It is now possible to Simulate multiple toolpaths, they will be simulated in the order 
they were selected and displayed in different colours. 
 
6499: Import: Fixed an issue with Iges surface type 143, finding the correct outer boundary when using the 
external trimming surface. 
 
6500: Toolsheet: Added a comment to tool sheet and tape file to indicate the cutter compensation direction for 
along curve toolpaths that are using cutter compensation. 
 

 

 
This is the Classic plus toolsheet, but if cutter comp 
left or right is enabled, the comment will appear on 
all toolsheet styles. 

 
6546: Linking: Horizontal Area Passes: A new option has been added 'Link from outside". When the option is 
selected, we will attempt to order passes starting from the outside and working inwards. 
 

 

 
 
6549: UI: Space bar can now tick and untick items in the tree view. 
 
6558: There was a long-standing bug in the process manager dialog where pausing a queued plan set it's 
state to paused. If this plan is then set to run, the state would appear as "Running" but in fact the execution 
was never started. This is now fixed by leaving the status of queued plans as queued when selecting Pause. 
 
6579: Cutter Simulation: The calculation of the default initial stock size has been improved to respect the height 
of the first pass (the top of the simulation stock is no longer taken from the triangulated surfaces). This is useful 
when starting above the part or for more localised machining that needs to start below the top of the model. 
 
6591: UI: Improved the performance of the selection drag box. Also fixes ticket 6568. Should also fix the lag in 
the measuring rod. 
 
6596: Toolsheets: Improve table printing in ‘toolsheet-classic’, ‘toolsheet-extended’ and ‘toolsheet-classic-
plus’. Now the table will do the page breaks nicely. Also fixes tickets 4563 and 4014. 
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6668: UI: The command "Set Coordinate System" has been added to the context menus. 
 

 
 
6678: When loading a step file, we have added a property tab after the header tab in the File Properties Dialog. 
This Properties tab displays the DESCRIPTIVE_REPRESENTATION_ITEM the user specified in the CAD 
system. 
 

 
 
6683: Curves: Extract curves now uses parametric curve data wherever possible for better results. Also fixes 
tickets 4244, 5264, 6065, 6066, and 6315 
 
This results in the removal of the ‘Extract Converted Curves’ button, and the renaming of ‘Extract PCurves’ 
button to ‘Extract Curves’, to do what both ‘Extract Converted Curves’ and ‘Extract PCurves’ did in v17 and 
earlier. 
 

  

 

    New v18     Old v17  
 

6717: UI: Restored drawing of a sphere for user feedback on selecting a parameter value from a surface, so 
you can see where the position was taken.. 
 
6734: UI: Updated print preview mode to use the ribbon interface. This also fixes tickets 6790, and 6207. 
 
6735: Post processors: ISO: Linking moves between holes, if the options: "Output true rapids" was set 'false', 
"Output feed in cycle" and "Override feedrate" were both set 'true' or if the options: "Output true rapids" and 
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"Override feedrate" were both set 'false', and "Output feed in cycle" was set 'true', then the move between 
holes would be performed at the drilling feedrate, when you would expect it to be rapid. This has now been 
fixed. 
 
6760: UI: Fixed the behaviour of the "Print" and "Macro" buttons in the ribbon interface application menu. Now 
clicking on the Macros or Print will display the sub menu (not close the menu). 
 
6761: UI: Added Axes length setting in pixels. When Tools > Options > Axes > Fixed axes length is disabled, 
you can specify the axis length in pixels. 
 

 
 
This will allow the axis to be the same size (on the screen) irrespective of the zoom / viewing scale. 
 
6777: The installer now shows DEPOCAM Solutions Limited as a verified publisher. 
 
6789: Linking: Machine Along Curve: The horizontal lead in and horizontal lead out angles have been added 
to the User Interface. 
 

 

 
Using a lead in / out angle of 
0 degrees, (the default). 

The linear exteneion was 
also increaced in both 
examples here. 

 
Using a lead in / out angle of 
45 degrees. 

 
6801: When the surface triangulation produces a broken surface, we now try a slightly (5%) slacker tolerance 
to try and load the surface. 
 
6807: Tool Holder: It is again possible to include a disc at the top of a tool holder definition, as it was before 
release 15.0.02. In particular, a top disc can again be included as part of an Inspection Probe holder. 
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6889: Import: There were occasions when open curves were being read in from a CREO file were being closed 
in error, this has now been fixed. 
 
6890: Analyse Curves: Added a new function to analyse curves (Similar to Analyse Toolpath). 
 

 

 
 
6911: Five-Axis: Flank Machining. The default start point has now been lifted to more sensible height. 
 
6916: Linking: There was a problem with helical machining which could lead to passes being linked out of 
order. This has been fixed. 
 
6918: Toolpath Point Spacing: Improvements have been made to the regularity of toolpath points when the 
'Point Spacing' option is chosen on machining dialogs. Calculation speeds for the option have been improved 
by approximately 35% for moderate-to-large sized jobs. Also fixes ticket 6919. 
 
6933: UI: Fixed a possible issue with the mouse wheel not changing the ‘2D Tool Guide’ diameter when the 
2D Tool Guide dialog was active. Previously this was affected by the "Scroll inactive windows when I hover 
over them" setting in Windows, this is now not the case. 
 
6937: Helical Machining: Fixed a problem where the initial Waterline Pass was sometimes not created at the 
top of a section of Helical passes. Also fixed a problem which could lead to an unnecessary retract between 
the initial Waterline pass and the Helical passes. 
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6940: Five Axis: Added support for flat bottomed tapered barrel cutters in Five-Axis machining plans. Updated 
the documentation. 
 

 
6946: UI: Fixed a problem where the label for a bore milling cycle could be wrong after selecting and modifying 
a tool from the most recently used list. 
 
6948: Bug fixes: If the component ‘node’ name is available, use that name for the folder, instead of the top 
component's child's name. 

  
   In v18.0.00    How it was in v17.0 

 
6964: Import: There were occasions when opening a Step file, would cause an exception due to a date-stamp 
error, and the surfaces / curves would not be loaded, this has now been fixed. 
 
6971: UI: There were occasions when the overall length on the tool / cutter page was not being updated when 
it should have been, this has now been fixed. 
 
6972: Update the Datakit libraries to 2020.3. These are the Catia, STEP and UG-NX formats. Also fixes tickets 
6833, 6853, and 6843 
 
6973: UI: Fixed an issue where surfaces were drawn incorrectly when initially drawn with translucent rendering. 
 
6982: UI: When a drill loaded from the tool database had its Body Length modified, the fields become editable 
except for the Overall Length, it should have been editable too, this has now been fixed. 
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6983: Post processors: ISO: Added a new option “Repeat the tool number after the tool number suffix” to allow 
the tool number to be output again after the Tool number suffix. By default, this option is set 'false' so not to 
affect any existing posts. For example, if set 'true' T5 could be output as: T5.5 

 
 
6984: Documentation: Updated the ISO post processor help to include the "Repeat the tool number after the 
tool number suffix" option - ticket 6983 
 
6989: Machine Simulation – Five axis: There was a problem where the translate option was not always working 
correctly, this has now been fixed. On this machine we have a table/table machine, the C axis rotates endless. 
In a 5 axis tape file we will rotate the C axis to the following position if the A axis stays at 0 and starts to tilt. 
This rotation block will be output with an A axis rotation only. In the next block we continue the work with 
XYZAC values. 
 
This works fine without any problems in mw2019_08. In mw2020_04 it will work correct as well if we don't 
enter a transformation in the MW_TRANSFORM workpiece_transform block. If a transformation is applied to 
define a different workpiece origin the block with an A axis rotation only before the A axis starts the tilting will 
cause an incorrect move of the cutter in the simulation. This problem does only appear if a transformation is 
applied. Also fixes ticket 5572 
 
6991: UI: Removed the old toolbar interface. 
 
6994: Import: Updated Granite to v13.0.1.0. 

 
 
6996: Selected Surface Machining: STL file inputs to selected surface machining plans could lead to "Record 
is not of the expected type" exceptions. This problem has now been fixed. 
 
6998: UI: Corrected formatting of Toolpath analysis dialog 
 
7010: UI: The Desk-top icon for the License Manager has been updated. 
 
7011: UI: The display of T-Slot cutters where the Flute Length was equal to 2 * Corner Radius was incorrect, 
this has now been fixed. The toolpath would be calculated correctly it is just the rendering of the cutter in the 
dialog that was wrong. 
 
7013: Tool Database: When creating a cutter the Advanced Barrel type was incorrectly enabled for non-Barrel 
cutters, this has now been fixed. 
 
7016: Post processor: Siemens: The Output second clearance, was only being respected for spot drilling 
(without a dwell) for all other cycles it would always be output. This has been fixed. This is unlikely to affect 
any existing post processor, but one that should be checked. 
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7022: The file property for IGS, Granite, DataKit, VDA and STL files is now stored in the database. When 
reloading the file, it can display in the File > Properties. 
 

 

 
 
Model file details, shown above. 
 
DEPOCAM dca file details, shown right. 

 
 
7023: UI: Update the Tool Design dialog for saving a tool from a passes dialog to the tool database to grey out 
the barrel cutter parameters if they are not required, instead of removing the parameter and leaving the label. 
 
7025: Five axis: Updated to ModuleWorks libraries to MW2020-08. 
 
7026: Post Processing: ISO, Heidenhain, Siemens, and GPost-APT: For STEP files, user can specify the 
component property can be output to the NC file as comments. There is the new option “Output STEP Property 
comments” that can be set ‘true’ or ‘false’, the default is false so not to affect any existing post processors, it 
needs to be set ‘true’ if you want / require the STEP Property comments. Additionally, there is the “STEP 
Property comment lines to output”, it is possible to set which STEP Property comments are output. This is 
referring to the line numbers seen when you view the files properties (See ticket 6678). The default is “1,3,10-
14,17-20” (as a random example), you can have the line number, or a range 10-14 each line number must be 
separated by a (,) comma, and hyphen (-) between a range, do not leave any spaces. 
 

 

 
The STEP file comments 
options in the post 
processor options. 
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The output in the NC file. 

 
7027: Fixed a problem where a database was not always marked as modified when plans were created after 
a save was requested but before it had completed. Also fixed a problem where a database was marked as 
modified due to the auto-save running. Also fixes tickets 5157 and 5287. 
 
7029: Selected Surface Waterline: A problem has been fixed where gaps in selected-surface-waterline passes 
could appear when smoothing was used. 
 
7030: Linking: Fixed a problem which could lead to missing horizontal arcs. 
 
7031: Post processor: Siemens post: It was possible to set the "Output Clearance in cycle call" as false in the 
post processor options, but this would result in an undefined parameter value of -99999.0 being output, which 
was wrong. This has been corrected. 
 
7032: UI: Fixed the OpenGL printing setting that were not working correctly. 
 
7034: UI: There were occasions when the Barrel type pulldown option was not set correctly when using a tool 
from the tool folder. This has now been fixed. 
 
7036: Post Processor: GPost: Output a PPRINT statement for the Save Z and Clearance plane. (five axis 
toolpaths only output the Safe Z). 
 
7037: UI: Page orientation in the print preview now updates when changed in the page setup dialog. 
 
7038: UI: Selected Surface Machining: An option has been added to the Machining Passes dialogs for Selected 
Surface Machining to not select the created plan but to retain the current selections, this overrides the global 
setting in options. Updated the documentation. 
 

 

This can make life easier if for example using selected surface 
machining to waterline between 30° and 90°, and then want to raster 
the same surface between 0° and 40° 
By ticking the Preserve selection, it is possible to just pick raster 
passes, (no need to reselect the surfaces, again). 
By default the option is not ticked. 
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7039: UI: Added horizontal and vertical centring options to the printing page setup dialog. 
 

 
 
7057: Post processors: ISO, Siemens and Heidenhain: If using Incremental motions, it was possible to get 
X/Y/Z0.00 which has no effect motion wise. Now if the motion is 0.0 as an incremental movement, the X/Y/Z0.0 
is no longer output. 
 
7065: UI: It is now possible to create a silhouette boundary from a stock model. The option to create a silhouette 
boundary has been added to the context menu for a stock model. Updated the documentation. 
 
7071: UI: There were occasions when copying and pasting parameters as values caused a plan to fail to run, 
this has now been fixed. 
 
7079: Performance: Selected Surface Waterline: Improved overall performance by approximately 10% 
 
7084: Import: Fixed a problem where Creo assemblies failed to load. Creo parts with multiple bodies now load 
into a single folder unless "Load Component Information" is ticked when each body will load into a separate 
folder in the same way as assemblies. Bodies that were not named in Creo are named "Body 1", "Body 2", etc. 
 
7086: Linking: Fixed an exception which could occur in boundary passes linking. 
 
7087: Fixed a problem where curves in rotated space would produce incorrect along curve passes. This also 
fixes ticket 7282. 
 
7092: Cutter Simulation: When saving the current stock as a STL file, we save the encoded colours, so these 
colours are displayed when STL file is loaded back into DEPOCAM. 
 
7093: When the “Load component information” is selected, Catia and SolidWorks files will now give the correct 
folder names in the tree view to be consistent with the component names in the file. 
 
7102: Improved the graphics performance when keyboard keys are held down. 
 
7104: UI: The colours for the Passes and Boundaries icons have been updated for clarity. 
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7109: Updated the Datakit libraries to 2020.4. This is for an update to the UG-NX reader. Also fixes tickets 
6852, 7085, 6962 and 6985. 
 
7112: UI: Edit > Folder by Colour now creates folders for the colours of the selected surfaces only. If no 
individual surfaces are selected, then folders are created for all colours found as before. This makes it easier 
to generate macros driven by colour selection. 
 
Mini guide 

 

 
The part is loaded, and the Triangulated 
surfaces folder has all the surface, irrespective 
of their colour. 
 
This example has 7 different colours 

 

With the Triangulated surfaces selected, Edit > 
Folder by Colour can be picked 

That will create a 
Triangulated surfaces 
folder for each colour, 
based in the Red, Green, 
Blue values for that 
colour.  

 

 
With a surface selected, and then picking the 
Edit > Folder by colour 

 

Only surfaces of the selected colour will be 
coped to a new Triangulated surfaces folder. 
 
It is possible to select 3 different and Edit > 
Folders by colour, that will create 3 new 
Triangulated surfaces folders 

 
7121: UI: The combining of transformed geometry folders has been extended to include curves, points and 
boundaries. 
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7123: Selected Surface Waterline: A problem has been fixed where small gaps could appear erroneously in 
Selected Surface Waterline Passes. 
 
7127: Pencil Passes: A problem has been fixed where pencil passes were sometimes not calculated for small 
radius cutters and where surfaces met at very shallow angles (less than 2 degrees bi-tangency angle). 
 
7129: UI: Five axis: The dialogs validation for Tapered Barrel cutters have been improved so that the minimum 
flute length is prompted when the validation fails. 
 
7132: UI: When loading a new geometry file or running a macro, the recycle folder is added when the tree view 
is created in place of the folder "Editable Boundaries 1" 
 
7135: UI: It was possible to select a shaft profile plan created from an Adaptive Clearance toolpath and use 
for the Sister Tooling or Split Toolpath options, this has now been blocked, as it would cause DEPOCAM to 
crash. 
 
7138: UI: Folder names for transformed boundaries are now consistent with other transform plans. 
 

 
 
7139: Post Processor: Heidenhain: Added CYCL DEF 32.0 alternatives for DMG Mori (CYCL DEF 392) and 
Hermle (CYCL DEF 326) machines.  
 
Both will use the pre-existing "Thickness at which CYCL DEF 32 Mode changes" option, although this has 
been reworded as "Thickness at which CYCL DEF 32 / 326 / 392 Mode changes" as it is used for: CYCL DEF 
32, CYCL DEF 326 and CYCL DEF 392. 
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Both the ‘Use CYCL DEF 392’ and ‘Use CYCL DEF 326’’ are set as false by default, so existing post processors 
are not affected. The name change “Thickness at which CYCL DEF 32 / 326 / 392 Mode changes” will not 
affect existing post processors functionality. 
 
7140: Improved the speed / performance of the selection drag box and boundary editor. 
 
7147: Fixed inconsistency in the rotation model of the coordinate system. Sometimes the values were XYZ 
rotations, sometimes ABC rotations. Also fixes ticket 6582. 
 
7148: Import: when loading component names, if the folder has one component the component now has the 
correct name. 
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7151 and 7347: Toolsheet (Extended): Added the ‘Peck depth’ and ‘Number of holes’ for canned (drilling) 
cycles. They are shown where a milling operation would show the Step down and Step over. If the cycle does 
not have a peck depth parameter (Spot drill, Ream, Bore ..) ‘Not available’ will be shown for the ‘Peck depth’. 
 

 
 
7152: ModuleWorks: Updated ModuleWorks libraries to MW2020-12, this also fixes ticket 7156. 
 
7154: Selected Surface Machining: Performance: Machining could be slow in examples where a small number 
of surfaces are selected from a large set of surfaces, this has now been fixed. 
 
7158: Fixed a crash that could occur when post-processing in parallel on non-English computers. 
 
7169: UI: Revolved and Ruled surface plans can now use the colour of the input curve as the colour of the 
triangulated surface. This option also works for the Planar Patch plan, if input curves are the same colour. 
 
7171: Performance: Selected Surface Waterline: The performance of Selected Surface Waterline machining 
for models having a large number of surfaces has been significantly improved. 
 
7172: Fixed an issue where very small deviations could be introduced to coordinate systems. 
 
7173: Linking: Fixed a crash that could occur when linking Rest Roughing passes. 
 
7177: UI: It was possible to close the Draft Angle, Curvature and Surface comparison dialogs with the escape 
key, which left the interface in a state where no further analysis is possible, this has now been fixed. 
 
7180: UI: The rendering of a DoveTail, Lens & T-Slot tool with a zero corner radius was incorrect, this has now 
been fixed. The calculated toolpath would have been correct. 
 
7185: The trimming option UV / XYZ is now only enabled for the IGES file when loading through our IGES 
reader. It had no function if reading an IGES file and converting to NURBs. 
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7188: Post processors: Heidenhain: Added the option "Output the feedrate in the motion block" to allow the 
feedrate to be output as part of the motion block / line. The default setting is false, this will output the feedate 
on its own block before the motion, as it did in v17.0 and before so existing posts are not affected. 

 
 
7193: The program could lock when generating bitmaps for the toolsheet. This is now fixed. 
 
7194: UI: Toolpath/Curve Analysis dialogs now allow for the resizing of the graphs. 
 
7200: Fixed an error message when the Custom View dialog is first run. 
 
7204: UI: Fixed the full screen mode when using the ribbon interface. 
 
7207: Machine Simulation: It was possible to have the wrong path to the resource file in the machsim.ini file 
when you run the Simulator in different versions, this has now been fixed. 
 
7209: Rotated toolpaths will now more accurately handle rotations that are close to an axis. 
 
7210: UI: Surface and boundary independent macros now output a friendlier message when run without any 
items selected. 
 
7211: UI: Creating a Cloned Window while running the Cutter Animation would cause DEPOCAM to crash, this 
has now been fixed. 
 
7213: Machine Simulation: The selected fixture was not being checked for collisions by the simulator, this has 
now been fixed. 
 
7215: Cutter Simulation: There were examples where very thin long toolpaths (drilling a holes for example) 
could cause the simulation to crash, this has now been fixed. 
 
7219: Post processors: the parallel post processing has been enabled again. It was disabled in v15.0.05 (ticket 
5040) because of some reports of it being slower on some Xeon based PC's. Further testing suggests that on 
average it does offer a reduced post processing time for most, especially those with Core i5 / i7 or i9 CPU's.  
 
However, if you do use the Max spindle speed check, and have the pop-up message set true (it is by default), 
you will be better off without the Parallel processing. If you encounter slower processing times, the Parallel 
processing can be disabled. For the ISO, Siemens, Heidenhain or SCL post processors, the "Performance 
over spindles RPM check" in the "Spindle setting" options will allow this. If you use Gpost, there is a "Use 
Parallel processing" option in the "General" section. 
 
If you have a Xeon based PC, you can use the "Performance over spindles RPM check" to disable the Parallel 
processing, this is no need to enable “Max spindle speed check” if you do not want it. 
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7221: Five-Axis: Flank Machining the "Back side" option has been added to the Side combo box control on the 
dialog. 
 

 
 
7240: Fixed issue where the bottom of blind holes was not always being detected correctly. 
 
7243: UI: Ribbon. The order of the Tabs in the ribbon has been changed to Points, Boundaries, Curves, 
Geometry (Surfaces) 
 

 
 
7254: UI: Machine Simulation - We now allow the selection of multiple toolpaths and a surface folder for 
machine simulation. There is no longer the need to have set the Cutting Parameter. 
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7259: Post processors: ISO, Heidenhain, and Siemens: Added the option "Tip inspection uses Opstop, not 
Stop" in the 'Stop / End settings' section to allows an Optional stop or Programmed stop to be output when the 
tool retracts for a Tip inspection (using the force a retract every nn units). By default, this option is set 'true' so 
not to modify any existing post processors.  
 

 
 
7279: UI: The dialog validations for corner radius have been improved for Barrel cutters, also the rendering of 
a standard Barrel cutter with a zero corner radius was not correct this has been fixed. 
 
7280: Update Datakit libraries to 2021.1. Provides SolidWorks 2021 support. This also fixes tickets 7088, 7145, 
7149 and 7225     Has now been added to v17.0.10 
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7281: Linking: Waterline Style Passes with zero ramp angle. We will now try and apply a quarter turn of 
horizontal arc, earlier versions would have used a vertical arc. 
 

 

    V17.0 would have a vertical arc in move     V18.0 will fit a horizontal arc in move 
 
7289: Import: If a multibody model contains fewer bodies than it should, DEPOCAM will now display the 
successfully loaded bodies correctly. 
 
7293: Post processors: Heidenhain: Added options to output some text (comment or machine command) 
before a Spot drilling, Deep drilling, Tapping, Reaming, or Boring cycle (the option pre-existed for Bore milling 
and Thread milling). The options are: "Text output before spot drilling cycle", "Text output before deep drilling 
cycle", "Text output before tapping cycle", "Text output before reaming cycle", and "Text output before bore 
cycle". By default, nothing is set, so existing post processors are not affected. The pre-existing "Text to be 
output before a cycle" and "Text to be output after a cycle" have been repositioned above these new options 
in the post processor configuration options. 
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7294: UI: It was possible to enter a value of zero for the Repeat Count when doing an Edit > Transform, this 
would cause DEPOCAM to crash, this has now been fixed. 
 
7297: Post processors ISO, Heidenhain, Siemens, and GPost-APT: Changed the options descriptions to be: 
"Output STEP Property comments" and “STEP Property comment lines to output". Set the "STEP Property 
comment lines to output" default to be (“”). The 'parameter descriptions' could be reworded to be a little clearer 
"Output STEP Property comments" “STEP Property comment lines to output". 
 

 
 
7314: UI: The icons on the passes ribbon have been reorganised to simplify the layout and provide extra labels. 
 
Below, the passes ribbon in v17.0 

 
 
Below, the passes ribbon in v18.0 

 
 

7321: Machine along curve now uses the rotation of an extracted curve if no bounding box given. 
 
7343: Linking: Fixed an issue with an unsafe linking move in Waterline Offset passes. 
 
7349: Stock Model: It was possible for DEPOCAM to crash if the input stock model to a plan is changed to a 
single stock model, this has now been fixed. 
 
7351: Import: Fixed some cases where some surfaces would not load through the Datakit and Granite readers 
due to having unrecognised subordinate entity switch values. 
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7357: UI: It was possible for the Options > Post Processor page to cause DEPOCAM to crash, if a Post 
Processor did not exist, this has now been fixed. 
 
 
7363: UI: Additional ribbon styles "Windows 2000", "Windows XP" and "Office 2003" have been added to the 
Ribbon Style selection to allow greater choice of styles. 
 

 
 
7369: Linking: Clear surface within distance is now selectively enabled based on retract style for all strategies 
(except Waterline Linking). 
 
7372: UI: Tool Import: Top Bottom Connections are now imported from text files along with other tool data. The 
connections are also now stored and not lost when a Plan dialog is closed. 
 
7380: UI: Fixed "Wireframe HLR" icon in the ribbon points tab. 
 

 
 
7382: UI: The properties dialog for a plan can now be accessed by double-clicking on the plan with the Ctrl 
key pressed. Mouse right > Properties still works. 
 
7383: Post Processors: Siemens: This post processor had some options in the canned cycles that were never 
used. These options: "Output Z coordinate of cycle points", "Output the start point in cycle call", "Cycle initial 
return Z level prefix", "Dwell prefix", "Depth prefix", "Clearance prefix", "Second clearance prefix", "Peck depth 
prefix", "Chip break peck backoff", "Bore offset prefix", "Output feedrate in drill, ream, bore cycles", "Output 
feedrate in tapping cycles", "Output pitch tapping cycles", "Output pitch as decimal", "Output dwell as decimal", 
"Tap pitch prefix", "Output spindle RPM tapping cycles", "Tap RPM prefix", "Drilling block suffix", "Reaming 
block suffix", "Tapping block suffix", "Boring block suffix" have been removed, as they had no function, so no 
post processors are affected. 
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7385: UI: Cutter Animation and Simulation: the currently animated toolpath name has been added to the dialog 
caption. 
 

 
 
7398: ZigZag Passes: The ZigZag roughing now works on multiple selected plan boundary plans. 
 
7397: Convert To Boundary: Convert To Boundary has been adapted so it can handle multiple input plans. 
Convert To Boundary now handles Drilling Data Top folders. 
 
7406: UI: Improved the behaviour of range selection in the tree view. 
 
7411: Adaptive Clearance: It was possible to get a validation failure on the dialog for an incorrect Intermediate 
StepDown when it was not enabled, this has now been fixed. 
 
7412: Extract Curves: Fixed a situation where extracting the curves from a surface that had been externally 
trimmed would also recover the curves that had been removed. 
 
7414: ModuleWorks: There was a problem with the ModuleWorks Advanced page not remembering changed 
parameters, this has now been fixed. 
 
7418: UI: The Tab key can now be use to navigate around the point editor table. 
 
7434: ModuleWorks: If a flat-bottomed drill had been defined, and was used to create a stock model or cutter 
simulation an exception was thrown, this has now been fixed. 
 
7435: Post Processors: Vericut tools list: Corrected an error for a lens cutter where the corner radius was 
incorrect. Added support for Tangential and Tapered barrel cutters. 
 
7444: Stock Models: The performance of large Multi-Axis stock models has been improved. 
 
7453: Selected Surface Machining: Where surfaces are ‘selected by layer’, they are now machined in the same 
way as the original surfaces. Surfaces selected by colour are used for selected surface machining. 
 
7455: Edit to Toolholder: We now pick up the shank definition from the input passes plan. This avoids confusion 
with names when selecting the tool from the Tool database. 
 
7456: Cutter Simulation: Improve speed and memory usage. 
 
7458: UI: Corrected the handling of editable points and boundary plans within a sub-selection. 
 
7459: UI: Improved the time taken to delete an Editable Point from an editable points plan. 
 
7461: Post Processor: Heidenhain: Added the option to output a "CYCL DEF 302" for a Correa machine, to be 
output prior to the PLANE SPATIAL command for 3+2 machining. 
The new post options are:  
"Output CYCL DEF 302" - Which is set false by default so not to affect existing post processors,  
“Start of CYCL DEF 302 text” – This is any text required before the CYCL DEF 302 block. 
"CYCL DEF 302 prefix" – For example: “CYCL DEF 302 Rotate body C2” 
"CYCL DEF 302 Q value" – For example: "Q1402 = " 
"CYCL DEF 302 suffix" – For example: "   ;Pos. C2" 
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7463: Linking: Axially Offset Horizontal area passes. Fixed an issue which could result in a missing lead out 
and linking move in the toolpath. 
 
7492: Added the "Use project settings, Use current view or None" control options for:  
1) Converting curve, point, drilling data to a boundary.  
2) Creating a boundary from text and P-curve from selected surfaces. 
3) Create drilling data folder (and the triangulated surfaces are selected). 
 

 
 
This is now more consistent with other plans where the rotation may need to be respected. 
 
7493: Cutter Simulation: Graphics could be unresponsive after jumping to end of the simulated toolpath, this 
has now been fixed. 
 
7495: UI: The speed of the selection of plans on the Inputs page for a plans dialog has been improved. 
 

 
 
7496: UI: We now pick up the "top connection" from the holder page and apply it as a filter for loading holders 
from the database, when using "filter by Connection". 
 
7500: UI: The order of the passes ribbon has been changed and the context menus modified to match.  
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7504: Post Processors: Added a "Spindle direction option" in the cutting parameters plan, the post processors 
can output the relevant machine code, normally M3 or M4. 
 

 
 
7508: Helical Machining: Fixed a problem which stopped Helical Passes from Drilling Data/Points from 
working. 
 
7512: Five-Axis: There were occasions when using a revolved surface in Five-Axis plans would cause an 
exception, this has now been fixed. 
 
7515: Convert To Boundary: The conversion of rotated curves to boundaries has been improved. We now pick 
up the rotation from the input curves wherever possible. Also running ‘Convert to Boundary’ on drilling data 
with sub-selection will no longer produce a warning message. 
 
7516: UI: The Boundary icons have been updated for clarity. 
 

 
 
7518: UI: Edit > Folder Contents on an Editable Boundaries plan would fail, this has now been fixed. 
 
7534: Import: Updated the Datakit libraries to 2021.2. This also fixes tickets 7337, 7339 and 7368 
 
7535: Import: File associativity now works with Creo files without the version number suffix  (i.e. test.prt.5). 
 
7543: There were occasions where multiple graphics windows which are not needed were being created when 
a dca was opened, this has now been fixed. 
 
7556: Trim To Toolholder: A problem which resulted in trimming being applied in regions where we would not 
expect it, has been fixed. 
 
7574: UI: The plan label size in the status bar has been increased by 50% 
 
7575: Linking: The Lead out part of a smooth connecting move is now output at RampUp feedrate. 
 
7579: Stock Models: When creating a Stock Model from a Five-Axis toolpath with a Three-Axis option using 
an Advanced Cutter (dove-tail or T-slot), the correct Stock Model  was not being generated. This has now been 
fixed. 
 
7581: Combine Folders: When using combine folders it was possible to create a tessellation with more than 
one copy of the same surface. This has been fixed. 
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7585: Post processor: Heidenhain: Added a couple of options to output a comment at the end of a toolpath. 
For a 3 axis toolpath, there is the option: "Text at the end of a 3 axis toolpath". For a 3+2 axis toolpath, the 
option: "Text at the end of a 3+2 axis toolpath” and will be output before the 'rotation back to zero' if used.  
There is nothing set for either of these by default so as not to affect existing post processors. 
 
7587: UI: The speed of the displaying of the context menus and dialogs has been improved. 
 

 
 
7595: Post processors: ISO and Siemens: The option (machine code) for cancelling a canned cycle would not 
include the block number on any additional lines, if “\n” was used (For example "G80 \n (Test)" -- G80 would 
have the block number, but (Test) would not). The block number will now be output on blocks created by the 
\n function. 
 
7611: UI: Mouse right context menu: The Curvatures, Draft Angles and Surface Comparison options have been 
moved to a Sub-Menu on the Surfaces context menu. This to reduce the need to scroll up and down a long 
menu. 
 

 
 
7619: UI: Fixed an issue with boundaries being drawn higher than they should be. 
 
7624: UI: There were occasions when resetting the parameters to their defaults on the Tool or Cutter pages 
would not reset all the parameters correctly, this has now been fixed. 


